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Excel 2003 Object Model

Most of the objects in the Excel Object Model have objects with associated collections. The collection
object is usually the plural form of the associated object. For example, the Worksheets collection
holds a collection of Worksheet objects. For simplicity, each object and associated collection will be
grouped together under the same heading.

Common Properties with Collections
and Associated Objects

In most cases the purpose of the collection object is only to hold a collection of the same objects. The
common properties and methods of the collection objects are listed in the following section. Only
unique properties, methods, or events will be mentioned in each object section.

Common Collection Properties

Name Returns Description

Application Application Read-only. Returns a reference to the owning
Application of the current object. Excel, in this case

Count Long Read-only. Returns the number of objects in the
collection

Creator Long Read-only. Returns a Long number that describes

whether the object was created in Excel or not

Parent Object The Parent object is the owning object of the
collection object. For example, Workbooks. Parent
returns a reference to the Application object
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Common Collection Methods

Name Returns Parameters Description
Item Single Index as Returns the object from the collection
Variant with the Index value specified by the

Index parameter. The Index value
may also specify a unique string key
describing one of the objects in the
collection

Common Object Properties

Objects also have some common properties. To avoid redundancy the common properties and methods
of all objects are listed next. They will be mentioned in each object description as existing but are only

defined here.
Name Returns Description
Application Application Read-only. Returns a reference to the owning Application
of the current object—EXxcel, in this case
Creator Long Read-only. Returns a Long number that describes whether
the object was created in Excel or not
Parent Object Read-only. The owning object of the current object. For

example, Characters. Parent may return a reference to
a Range object, since a Range object is one of the possible
owners of a Characters object

Excel Objects and Their Properties,
Methods and Events

The objects are listed in alphabetical order. Each object has a general description of the object and possible
parent objects. This is followed by a table format of each of the object’s properties, methods, and events.
The last section of each object describes some code examples of the object’s use.

Addin Object and the Addins Collection

The Addins collection holds all of the Addin objects available to Excel. Each Addin object represents an
Addin shown in Excel’s Addins dialog box under the Tools = Add-Ins...menu. The Addin must be
installed (AddIn.Installed = True) to be able to use it in the current session. Examples of available
Addin objects in Excel include the Analysis Toolpack, the MS Query Addin, and the Conditional Sum
Wizard.
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The Add method of the Addins collection can be used to add a new Addin to the collection. The Add
method requires a FileName to be specified (usually with a XLL or XLA file extension). The Count
property of the Addins collection returns the number of Addins that are available for use by the current
Excel session.

Addin Common Properties

The Application, Creator, and Parent properties are defined at the beginning of this Appendix.

Addin Properties

Name Returns Description

CLSID String Read-only. Returns a unique identifier for the Addin

FullName String Read-only. Returns the full path and filename of the
associated Addin

Installed Boolean Set/Get whether the Addin can be used in the current
session

Name String Read-only. Returns the file name of the Addin

Path String Read-only. Returns the full file path of the associated Addin

Title String Read-only. This hidden property returns the string shown

in the Addin Manager dialog box

Example: Addin Object and the Addins Collection

This example ensures that the Analysis Toolpack is installed:

Sub UseAnalysisToolpack ()
Dim oAddin As AddIn
'Make sure the Analysis Toolpack is installed
For Each oAddin In AddIns

If oAddin.Name = "ANALYS32.XLL" Then
oAddin.Installed = True
End If
Next
End Sub

Note that instead of looping through the Addins collection, you could follow the online Help and use:

AddIns ("Analysis Toolpak") .Installed = True

Unfortunately, this approach may not work with a non-English User-Interface language, if the Addin’s
title has been localised.

643



P1: GIG
WY010-AppA WY010-Kimmel WY010-Kimmel-v1.cls May 29, 2004 1:20

Appendix A

Adjustments Object

The Adjustments object holds a collection of numbers used to move the adjustment “handles” of the
parent Shape object. Each Shape object can have up to eight different adjustments. Each specific
adjustment handle can have one or two adjustments associated with it depending on if it can be moved
both horizontally and vertically (two) or in just one dimension. Adjustment values are between 0 and 1
and hence are percentage adjustments—the absolute magnitude of a 100% change is defined by the shape
being adjusted.

Adjustments Common Properties
The Application, Creator, and Parent properties are defined at the beginning of this Appendix.

Adjustments Properties

Name Returns Description
Count Long Read-only. Returns the number of adjustments values
associated with the parent Shape object

Item Single Parameters: Index As Long. Set/Get the adjustment
value or values indicated by the Index parameter

Example: Adjustments Object

This example draws a block arrow on the sheet, then modifies the dimensions of the arrow head:

Sub AddArrow ()
Dim oShp As Shape

'Add an arrow head to the sheet
Set oShp = ActiveSheet.Shapes.AddShape( _
msoShapeRightArrow, 10, 10, 100, 50)

'Set the 'head' of the arrow to start 30% of the way across
'and the 'shaft' to start 40% of the way down.

oShp.Adjustments (1) = 0.3 'Left/right
oShp.Adjustments (2) = 0.4 'Up/down
End Sub

AllowEditRange Object and the AllowEditRanges Collection

The A1lowEditRange object represents a range of cells on a worksheet that can still be edited when
protected. Each A11owEditRange object can have permissions set for any number of users on your
network and can have a separate password.

Be aware of the Locked property of the Range object when using this feature. When you unlock cells,
then protect the worksheet, you are allowing any user access to those cells, regardless of the
AllowEditRange objects. When each AllowEditRange object’s cells are locked, any user can still edit
them unless you assign a password or add users and deny them permission without using a password.
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The AllowEditRanges collection represents all Al1lowEditRange objects that can be edited on a
protected worksheet. See the A11owEdi tRange object for more details.

AllowEditRanges Collection Properties

Name Returns

Count Long

Item AllowEdit
Range

Description

Read-only. Returns the number of A11owEditRange
objects that are contained in the area

Parameter: Index As Variant. Returns a single
AllowEditRange object in the AllowEditRanges

collection

AllowEditRanges Collection Methods

Name Returns
Add AllowEdit
Range

AllowEditRange Properties

Name Returns

Range Range

Title String

Users UserAccess
List

AllowEditRange Methods

Name Returns

ChangePassword

Delete

Unprotect

Parameters

TitleAs

String, Range

As Range,
[Password]

Description

Description

Adds an A11owEditRange object to
the A1lowEditRanges collection

Returns a subset of the ranges that can be edited on a

protected worksheet

Returns or sets the title of the Web page when the
document is saved as a Web page

Returns the list of users who are allowed access to the
protected range on a worksheet

Parameters

Password As
String

[Password]

Description

Sets the password for a range that can
be edited on a protected worksheet

Deletes the object

Removes any protection from a sheet or
workbook
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Example: AllowEditRange Object

The following routine loops through a list of range names in a worksheet and adds an A11owEditRange
item for each one whose name begins with "pc". It also denies access to the pcNetSales range to all but
one uset, who can only edit the range with a password.

Sub CreateAllowRanges ()

Dim 1Pos As Long

Dim nm As Name

Dim oAllowRange As AllowEditRange
Dim sName As String

With wksAllowEditRange
'Loop through the worksheet level
' range names
For Each nm In .Names
'Store the name

sName

nm.Name

'Locate the position of the "!"

1Pos

InStr(l, sName, "!", vbTextCompare)

'If there was an "!"...
If 1Pos > 0 Then

646

'Is there a "pc" just after the exclamation point

'If so, it's a range we want to create an AllowEditRange
object for

If Mid(sName, 1lPos + 1, 2) = "pc" Then

'Make sure the cells are locked
'Unlocking them will allow any user
' access to them.
nm.RefersToRange.Locked = True

'Pull out the worksheet reference (including the "!")
' from the range name
sName = Right (sName, Len (sName) - 1Pos)

'Create the AllowEditRange
'Remove the old one if it exists
On Error Resume Next

Set oAllowRange = Nothing

Set oAllowRange = .Protection.AllowEditRanges (sName)
On Error GoTo 0
If Not oAllowRange Is Nothing Then oAllowRange.Delete
Set oAllowRange = .Protection.AllowEditRanges.Add (sName,

nm.RefersToRange)

'If it's the sales range name. ..
If sName = "pcNetSales" Then

'Add a password, then

'Add a user and deny them from editing the range

' without the password

oAllowRange.ChangePassword "pcnsw"
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oAllowRange.Users.Add "RCR\AgamaOffice", False
End If
End If
End If
Next nm
End With

End Sub

Application Object

The Application object is the root object of the Excel Object Model. All the other objects in the Excel
Object Model can only be accessed through the Application object. Many objects, however, are
globally available. For example, the ActiveSheet property of the Application object is also available
globally. That means that the active WorkSheet can be accessed by at least two ways:
Application.ActiveSheet and ActiveSheet.

The Application object holds most of the application level attributes that can be set through the
Tools => Options menu in Excel. For example, the DefaultFilePath is equivalent to the Default File
Location text box in the General tab of the Options dialog box.

Many of the Application object’s properties and methods are equivalent to things that can be set with
the Options dialog box.

The Application object is also used when automating Excel from another application, such as Word.
The CreateObject function, GetObject function or the New keyword can be used to create a new
instance of an Excel Application object from another application. Please refer to Chapter 15 for
examples of automation from another application.

The Application object can also expose events. However, Application events are not automatically
available for use. The following three steps must be completed before Application events can be
used:

Create a new class module, say, called cAppObject, and declare a Public object variable in a class, say,
called AppExcel, to respond to events. For example:

Public WithEvents AppExcel As Excel.Application

Now the Application object events will be available in the class for the AppExcel object variable.
Write the appropriate event handling code in the class. For example, if you wanted a message to appear
whenever a worksheet is activated then you could write the following:

Private Sub AppExcel_SheetActivate (ByVal Sh As Object)

'display worksheet name

MsgBox "The " & Sh.Name & " sheet has just been activated."
End Sub
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Finally, in a procedure in a standard module instantiate the class created above with a current
Application object:

Private App As New cAppObject 'class with the above code snippets
Sub AttachEvents ()

Set App.AppExcel = Application
End Sub

The EnableEvents property of the Application object must also be set to True for events to trigger
at the appropriate time.

Application Common Properties
The Application, Creator, and Parent properties are defined at the beginning of this Appendix.

Application Properties

Name Returns Description

ActiveCell Range Read-only. Returns the cell in the active sheet where the cursor
is located

ActiveChart Chart Read-only. Returns the currently selected chart in the active
workbook. If no chart is currently selected, nothing is returned

ActivePrinter String Set/Get the name of the printer currently being used

ActiveSheet Object Read-only. Returns the currently active sheet in the active
workbook

ActiveWindow Window Read-only. Returns the currently selected Excel window, if any

ActiveWorkbook  Workbook Read-only. Returns the workbook that is currently active, if any

AddIns AddIns Read-only. Returns the collection of Addins currently available
for use in Excel

AlertBefore Boolean Set/Get whether a message pops up any time an attempt to

Overwriting overwrite non-blank cells by a drag-and-drop operation is
made

AltStartupPath String Set/Get the alternative startup file location folder for Excel

AnswerWizard Answer Read-only. Returns an object allowing manipulation of the

Wizard Answer Wizard

ArbitraryXML Boolean Returns a Boolean value indicating if the XML feature is

Support available in Excel

Available

AskToUpdate Boolean Set/Get whether the user is prompted to update links

Links whenever a workbook with links is opened
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Name

Assistant

AutoCorrect

AutoFormatAs
You
TypeReplace
Hyperlinks

Automation
Security

AutoPercent
Entry

AutoRecover
Build

Calculate
BeforeSave

Calculation

Calculation
InterruptKey

Calculation
State

Calculation
Version

Caller

CanPlaySounds

Returns

Assistant

AutoCorrect

Boolean

Mso
Automation
Security

Boolean

AutoRecover
Long

Boolean

X1
Calculation

X1
Calculation
Interrupt
Key

X1
Calculation
State

Long

Variant

Boolean

Description

Read-only. Returns an object allowing manipulation of the
Office Assistant

Read-only. Returns an object allowing modification of Excel’s
AutoCorrect features

Set/Get whether Excel automatically formats/creates
hyperlinks as you type

Set/Get the level of macro security used when Excel
opens a file programmatically. This setting is independent
of the macro security setting found in Security dialog

box in the Tools = Macro command, though the
msoAutomationSecurityByUI constant instructs the
property to use the setting found there

Set/Get whether Excel automatically adds a % sign when
typing a number into a cell that has a Percentage format
applied

Set/Get AutoRecover options such as Path and Time interval
Read-only. Returns the exact build number of Excel

Set/Get whether workbooks are calculated before they are
saved to disk. This assumes that formula calculation is not
set to automatic (Calculation property)

Set/Get when calculations are made automatically, manually,
or semi-automatically

Set/Get the key that can interrupt Excel when performing
calculations

Read-only. Indicates whether Excel calculations are in
progress, pending, or done

Read-only. Returns the Excel version and calculation engine
version used when the file was last saved

Read-only. Parameters: [ Index]. Returns information
describing what invoked the current Visual Basic code (for
example, cell function, document event)

Read-only. Returns whether sound notes are heard in Excel.
Property unused from Excel 2000 onwards

Continues
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Name Returns Description

CanRecord Boolean Read-only. Returns whether sound notes can be recorded in

Sounds Excel. Property unused from Excel 2000 onwards

Caption String Set/Get the caption that appears in the main Excel window

CellDragAnd Boolean Set/Get whether dragging and dropping cells is possible

Drop

Cells Range Read-only. Returns all the cells in the active sheet

Charts Sheets Read-only. Returns all the charts in the active workbook

Clipboard Variant Read-only. Parameters: [ Index]. Returns an array of format

Formats values (X1ClipboardFormat) that are currently in the
clipboard

Columns Range Read-only. Returns all the columns in the currently active sheet

COMAdJdAIns COMAddIns Read-only. Returns the collection of installed COM Addins

CommandBars CommandBars Read-only. Returns the collection of commandbars available
to Excel

Command X1Command Set/Get how commands are underlined in Excel. Used only on

Underlines Underlines Macintosh systems

Constrain Boolean Set/Get whether only numbers and punctuation marks are

Numeric recognized by handwriting recognition. Used only by
Windows for Pen Computing

Control Boolean Set/Get whether control characters are displayed for

Characters right-to-left languages. (Language support must be installed)

CopyObjects Boolean Set/Get whether objects (such as embedded objects) can be

WithCells cut, copied, and sorted along with cell data

Cursor X1Mouse Set/Get which mouse pointer is seen in Microsoft Excel

Pointer

Cursor Long Set/Get what type of cursor is used: visual or logical

Movement

CustomList Long Read-only. Returns the number of custom and built-in lists

Count used in Excel (for example, Monday, Tuesday, Wednesday.. .)

CutCopyMode X1CutCopy Set/Get whether a cut or copy operation is currently

Mode happening

DataEntry Long Set/Get whether locked cells can be edited (x10£ £ for editing

Mode allowed, x10n for editing of unlocked cells only, x1Strict
for editing of unlocked cells only that can not be canceled by
pressing Escape)

DDEAppReturn Long Read-only. Returns the result (confirmation/error) of the last

Code DDE message sent by Excel
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Name

DefaultFile
Path

DefaultSave
Format

DefaultSheet
Direction

DefaultWeb
Options

Decimal
Separator

Dialogs

DisplayAlerts

Display
Clipboard
Window

Display
Comment
Indicator

Display
Document
Action
TaskPane

DisplayExcel4d
Menus

Display
Formula Bar

DisplayFull
Screen

Display
Function
ToolTips

DisplayInsert
Options

Returns

String
X1File
Format
Long
DefaultWeb
Options

String

Dialogs

Boolean

Boolean

X1Comment
DisplayMode

Boolean

Boolean

Boolean

Boolean

Boolean

Boolean

Description

Set/Get the default folder used when opening files
Set/Get the default file format used when saving files
Set/Get which direction new sheets will appear in Excel

Read-only. Returns an object allowing manipulation of the
items associated with the Web Options dialog box

Set/Get the character used for the decimal separator. This is a
global setting and will affect all workbooks when opened.
Use Application UseSystemSeparators = True to
globally reset custom separators

Read-only. Returns a collection of all the built-in dialog
boxes

Set/Get whether the user is prompted by typical Excel
messages (for example, “Save Changes to Workbook?”) or no
prompts appear and the default answer is always chosen

Set/Get whether the Clipboard window is displayed. Used in
Microsoft Office Macintosh Edition

Set/Get how Excel displays cell comments and indicators

Set to True to display the Document Actions task pane

Set/Get whether Excel display Excel 4.0 menus
Set/Get whether the formula bar is displayed
Set/Get whether the Excel is in full screen mode

Set/Get whether ToolTips for arguments appear in the cell
when typing a function

Set/Get whether the Insert Options drop-down button
appears next to a range after inserting cells, rows, or columns

Continues
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Name Returns Description

DisplayNote Boolean Set/Get whether comments inserted into cells have a little

Indicator note indicator at the top right corner of the cell

DisplayPaste Boolean Set/Get whether the Paste Options drop-down button

Options appears next to a range after a paste operation. This is an
Office XP setting and therefore affects all other Office
applications that use this feature

DisplayRecent Boolean Set/Get whether the most recently opened files are

Files displayed under the File menu

DisplayScroll Boolean Set/Get whether scroll bars are displayed for all open

Bars workbooks in the current session

Display Boolean Set/Get whether the status bar is displayed

StatusBar

EditDirectly Boolean Set/Get whether existing cell text can be modified directly

InCell in the cell. Note that cell text can still be overwritten
directly

Enable Boolean Set/Get whether adding and deleting cells, rows, and

Animations columns are animated

EnableAuto Boolean Set/Get whether the AutoComplete feature is enabled

Complete

EnableCancel X1Enable Set/Get how an Excel macro reacts when the user tries to

Key CancelKey interrupt the macro (for example, Ctrl-Break). This can be
used to disable any user interruption, send any
interruption to the error handler, or to just stop the code
(default). Use with care

EnableEvents Boolean Set/Get whether events are triggered for any object in the
Excel Object Model that supports events

EnableSound Boolean Set/Get whether sounds are enabled for Excel

ErrorChecking Error Set/Get error checking properties such as

Options Checking BackgroundChecking, IndicatorColorIndex, and

Options InconsistentFormula. These options mirror rules

found on the Error Checking tab of the Tools => Options
command

Excel4Intl Sheets Read-only. Returns the collection of sheets containing

MacroSheets Excel 4 International macros

Excel4Macro Sheets Read-only. Returns the collection of sheets containing

Sheets Excel 4 macros

ExtendList Boolean Set/Get whether formatting and formulas are

automatically added when adding new rows or columns to
the existing lists of rows or columns
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Name

FeatureInstall

FileConverters

FileDialog

FileFind

FileSearch

FindFormat

FixedDecimal

FixedDecimal
Places

GenerateGet
PivotData

Height

Hinstance

Hwnd

IgnoreRemote
Requests

Interactive

International

Returns

MsoFeature
Install

Variant

FileDialog

IFind

FileSearch

FindFormat

Boolean

Long

Boolean

Double

Long

Long

Boolean

Boolean

Variant

Description

Set/Get how Excel reacts when an Excel feature is
accessed that is not installed (through the interface or
programmatically)

Read-only. Parameters: [Index1], [Index2]. Returns
an array of all the file converters available in Excel

Parameters: [fileDialogType]. Returns an object
that represents an instance of one of several types of file
dialog boxes

Returns an object that can be used to search for files.
Used in Microsoft Office Macintosh Edition

Read-only. Returns an object that can be used to search
for files

Set/Get search criteria for the types of cell formats to
look for when using the Find and Replace methods

Set/Get whether any numbers entered in the future will
have the decimal points specified by
FixedDecimalPlaces

Set/Get the decimals places used for any future numbers
Set/Get whether Excel can get PivotTable report data

Set/Get the height of Excel’s main application window.
The value cannot be set if the main window is
maximized or minimized

Read-only. Returns the instance handle of the instance
that is calling Excel. Used mainly by other custom
applications like those written in Visual Basic

Read-only. Returns the top-level window handle of the
Excel window. Used mainly by other custom
applications like those written in Visual Basic

Set/Get whether remote requests through DDE are
ignored

Set/Get whether Excel accepts keyboard and mouse
input

Read-only. Parameters: [ Index]. Returns
international settings for Excel. Use the
XlApplicationInternational constants
as one of the values of Index

Continues

653



P1: GIG

WY010-AppA WY010-Kimmel WY010-Kimmel-v1.cls May 29, 2004 1:20
Appendix A

Name Returns Description

Iteration Boolean Set/Get whether Excel will iterate through and calculate all
the cells in a circular reference trying to resolve the circular
reference. Use with MaxIterations and MaxChange

Language Language Read-only. Returns an object describing the language

Settings Settings settings in Excel

Left Double Set/Get the left edge of Excel’s main application window.
The value cannot be set if the main window is maximized
or minimized

LibraryPath String Read-only. Returns the directory where Addins are stored

MailSession Variant Read-only. Returns the hexadecimal mail session number
or Null if mail session is active

MailSystem X1Mail Read-only. Returns what type of mail system is being used

System by the computer (for example, x1Mapi, x1PowerTalk)

MapPaperSize Boolean Set/Get whether documents formatted for another
country’s/region’s standard paper size (for example, A4)
are automatically adjusted so that they’re printed correctly
on your country’s/region’s standard paper size (for
example, Letter)

Math Boolean Read-only. Returns whether a math coprocessor is available

Coprocessor

Available

MaxChange Double Set/Get the minimum change between iterations of a
circular reference before iterations stop

MaxIterations Long Set/Get the maximum number of iterations allowed for
circular references before iterations stop

MemoryFree Long Read-only. Returns how much free memory (in bytes)
Excel can use

MemoryTotal Long Read-only. Returns how much total memory (in bytes) is
available to Excel (including memory in use)

MemoryUsed Long Read-only. Returns how much memory (in bytes) Excel is
using

MouseAvailable  Boolean Read-only. Returns whether the mouse is available

MoveAfter Boolean Set/Get whether the current cell changes when the user

Return hits Enter

MoveAfter X1Direction Set/Get which direction the cursor will move when the

Return user hits Enter changing the current cell

Direction

Name String Read-only. Returns “Microsoft Excel”
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Name

Names

Network
Templates
Path

NewWorkbook

ODBCErrors

ODBCTimeout

OLEDBErrors

OnWindow

Operating
System

Organization
Name

Path

PathSeparator

PivotTable
Selection

Previous
Selections

ProductCode

PromptFor
SummaryInfo

Range

Ready

Returns

Names

String

Start
Working

ODBCErrors

Long

OLEDBErrors

String

String

String

String

String

Boolean

Variant

String
Boolean

Range

Boolean

Description

Read-only. Returns the collection of defined names in an
active workbook

Read-only. Returns the location on the network where the
Excel templates are kept, if any

Read-only. Returns a StartWorking object

Read-only. Returns the collection of errors returned by the
most recent query or PivotTable report that had an ODBC
connection

Set/Get how long, in seconds, an ODBC connection will be
kept before timing out

Read-only. Returns the collection of errors returned by the
most recent query or PivotTable report that had an
OLEDB connection

Set/Get the procedure that is executed every time a window
is activated by the end user

Read-only. Returns the name and version of the operating
system

Read-only. Returns the organization name as seen in the
About Microsoft Excel dialog box

Read-only. Returns the path where Excel is installed
Read-only. Returns a backslash (“\”) on a PC or a colon “:”
on a Macintosh

Set/Get whether PivotTables use structured selection. For
example, when selecting a Row field title the associated data
is selected with it

Read-only. Parameters: [ Index]. Returns an array of the
last four ranges or named areas selected by using Name
dialog box or Goto feature

Read-only. Returns the Guid for Excel

Set/Get whether the user is prompted to enter summary
information when trying to save a file

Read-only. Parameters: Cel1l1l, [Cell2]. Returns a Range
object containing all the cells specified by the parameters

Read-only. Determines whether the Excel application
is ready

Continues
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656

Name

RecentFiles

RecordRelative

ReferenceStyle

Registered
Functions

ReplaceFormat

RollZoom

Rows

RTD

ScreenUpdating

Selection

Sheets

SheetsInNew
Workbook

ShowChartTip
Names

ShowChartTip
Values

ShowStartup
Dialog

ShowToolTips

ShowWindowsIn
Taskbar

Returns

RecentFiles

Boolean

X1Reference
Style

Variant

Replace
Format

Boolean

Range

RTD

Boolean

Object

Sheets

Long

Boolean

Boolean

Boolean

Boolean

Boolean

Description

Read-only. Returns the collection of recently opened files

Read-only. Returns whether recorded macros use relative
cell references (True) or absolute cell references (False)

Set/Get how cells are referenced: Letter-Number (for
example, Al, A3) or RowNumber-ColumnNumber (for
example, R1C1, R3C1)

Read-only. Parameters: [Index1], [Index2]. Returns
the array of functions and function details relating to
external DLLs or code resources. Using Addins will add
external DLLs to your workbook

Set/Get replacement criteria for the types of cell formats
to replace when using the Replace method

Set/Get whether scrolling with a scroll mouse will zoom
instead of scroll

Read-only. Returns all the rows in the active sheet

Read-only. Returns a reference to a real-time date (RTD)
object connected to a RTD Server

Set/Get whether Excel updates its display while a
procedure is running. This property can be used to speed
up procedure code by turning off screen updates (setting
the property to False) during processing. Use with the
ScreenRefresh method to manually refresh the screen

Read-only. Returns whatever object is currently selected
(for example, sheet, chart)

Read-only. Returns the collection of sheets in the active
workbook

Set/Get how many blank sheets are put in a newly
created workbook

Set/Get whether charts show the tip names over data
points

Set/Get whether charts show the tip values over data
points

Set/Get whether the New Workbook task pane appears
when loading the Excel application

Set/Get whether ToolTips are shown in Excel

Set/Get whether each workbook is visible on the taskbar
(True) or only one Excel item is visible in the taskbar
(False)



















































































































































































































































































































































































































































































































































































































































































































































































































































































































































